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Dual Processing Overview 
Dual Processing was created to allow Financial Aid users to finish their current Aid Year processing in the 

Legacy system after PeopleSoft go live.  This short-term solution allows users the ease of continuing 

Financial Aid processing without converting over live data.  Users will finish processing in Legacy while 

preparing for the upcoming Aid Year in the PeopleSoft system.   

Ten interfaces were designed to allow users to process student aid as normally as possible.  These 

interface include the following: 

1.​ Bio-Demo 

2.​ Enrollment  

3.​ Student Career 

4.​ Student Degree 

5.​ Track Codes to Checklist Items 

6.​ Disbursements 

7.​ Census  

8.​ Work Study 

9.​ Reconciliation  

10.​SAP 

 

Each interface was created to move data between three systems, PeopleSoft, HPUX and FAM.  The first 

four interfaces (Bio-Demo, Enrollment, Career and Degree) create files that are moved to the HPUX 

system.  Similarly to SMS, users will be utilizing a cloned version of SMS data during the time they are 

working in Dual Processing.  Many of the jobs that are currently used in Legacy will be available.  Some 

have been altered or will not be available depending on the type of processing being done.   

The Track Codes to Checklist Item allows users to convert rollover track codes to checklist items in the 

PeopleSoft system.  This will help with preparations for the upcoming Aid Year in PeopleSoft where all 

processing will occur eventually.  

The Disbursements process starts in the Legacy FAS system where users will be running modified jobs to 

create a file that contains student disbursement data.  The posting process will occur in the PeopleSoft 

system.  This process will post those disbursements to student accounts by Student Financial users. 

The Census interface starts by pulling students who will be included in the census review.  This is done 

via a legacy Data Express procedure which creates a file that is uploaded into PeopleSoft and a compare 

report is created.  

The Work Study report pulls actual work study student earnings from HCM.  The values will be populated 

in FAM for reconciliation and reporting.  

Reconciliation and SAP use the same student population that is pulled from Legacy.  A file is created via a 

Legacy Data Express procedure and uploaded into the PeopleSoft Query Reporting Table.  Various 

queries will pull reconciliation values for the students identified in the Query Reporting Table.  The SAP 

process pulls that same student population into Aid Year Activation tables so FA Term can be built and 

the SAP calculations can be done for those students in PeopleSoft. 
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During Dual Processing users will be reporting all areas of Financial Aid via the Legacy systems.  This will 

include the following: 

●​ COD 

●​ FISAP 

●​ URR 

●​ WCG Interim 

The following pages will give in-depth detail of all things Dual Processing.  This will include insight and 

instruction on both PeopleSoft and Legacy processing.   
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FA Dual Processing Description – Outbound 
The outbound files from PS will consist of student data extracted into multiple files. For example, 

BioDemo data, Term Information, Enrollment Information, etc. will be placed in separate files. The core 

selection will be based on the Institution and Start Term entered on the Run Control record. All students 

in the Admissions or Enrollment tables with a term greater than or equal to the Start Term will be 

selected. All extracted data will use this core list of Empl IDs to extract the relevant data. The output 

paths will be defined in a crosswalk record.  

This interface includes a Run Control, which users can specify what Institution and Start Term to use. It 

will also contain checkboxes to identify which extract file(s) to produce.  

In addition, this interface provides the colleges the ability to utilize PS queries to extract PS data to be 

used in regular business processes. Colleges will upload legacy data for a desired group of students into 

the Query Reporting Table. Queries are created to pull data from both the Query Reporting Table and 

PeopleSoft to generate a single output. For example, the Census Date business process includes colleges 

extracting students from legacy, loading the data into the Query Reporting Table, and then running a 

query to pull enrollment data for the select group of students.  

 

FA Dual Processing Description – Inbound 
The two processes that use the Inbound Interface are Disbursement files and Track Codes.   

These files are created in Legacy via HPUX batch jobs and are transfer to the Axway that is connected to 

both Legacy and PeopleSoft systems.  The Axway connection passes files to and from the PeopleSoft 

server for processing.   

For the inbound files the Axway connection deposits the newly created Disbursement and Track Codes 

files onto the PeopleSoft servers. Users will be able to access and process these files via the interface 

processing in the Financial Aid module.   
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Outbound Process Flow 
Process Process Name Process Description Review Log Required? 

Student Bio-Demo Data 
I-111 

CTC_FBIO_AE Extracting Bio/Demo 
from PS to move to 
FAM.   

Y 

Student Enrollment 
Data 
I-121 

CTC_FAMSE_AE Extracting all student 
enrollment data from PS 
to move to FAM 

Y 

Student Career Term 
Data (Quarterly Data) 
I-112 

CTC_FAMSC_AE Extracts student career 
program details from PS 
to FAM 

Y 

Student Degree Extract 
I-123 

CTC_FAMSD_AE Extracts student degree 
data from PS to FAM 

Y 

Student Worker Payroll 
Extract​
I-115 

 Extracting all student 
enrollment data from PS 
to move to FAM 

 

 

 

Inbound Process Flow 
Process Process Name Process Description Review Log Required? 

Census Extract 
I-113 

   

Disbursement Data 
I-116 

CTC_I116_AE FAM to PS Disbursement 
and SF group post 

Y 

Tracking Code  
I-117 

CTC_TRKCD_AE Loading tracking codes 
to PS and converting to 
Checklist Items 

Y 

Student Financial 
Reconciliation  ​
I-114 

 Program compares data 
from FAEXP to awards in 
FAM 

Y 

SAP Extract​
I-118 

 FAM subset of students 
loaded to PS via Query 
Reporting Table 

Y 
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Dual Processing Business Flow  
The following table shows how Daily, Weekly and Quarterly processing occur while running Dual 

Processing.   

Task Sub Task Application Frequency Data  
Feed 
Require- 
ment 

Direction and  
Data Elements 

Business Process 

ISIR Load   FAM Weekly; 
specific to 
individual 
college’s 
specific 
business 
process. 

None 
needed 

 ISIR Load would be 
run as usual.  
No change to 
program. 

FA Load Tracking 
Codes 

FAM Weekly Yes, 
needed 

FAM to PS 
FAM Tracking 
Codes 
KW5001J 

Use KW5001J to 
extract roll-over 
and BankMobile 
tracking codes to 
create checklist 
items into PS. 
 
Schedule KW5001J 
to run on a nightly 
basis to pull 
desired track codes 
from legacy then 
add to PS. 
 

FA Load WCG 
Eligibility 

FAM Weekly  None 
needed 

 Run FAF Load as 
usual.  
No change to 
program. 

WCG Archive  
 

 HPUX 
(DX: 
SM9897R) 

Weekly None 
needed 

 Business as usual. 
But make sure ETL 
process from FAM 
to SAFER is still 
running. 
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College Bound 
Scholarship  

 HPUX 
(DX:SM9116R
, screen 
SM9117, 
batch job 
SM9118J) 

Weekly None 
needed 

 Business as usual.​
No change to 
program. 

FA Load Student 
Budgets 

FAM Weekly  None 
needed 

 Run FAF Load as 
usual. No change 
to program. 

FA Load  Bio/demo FAM Weekly  Yes, 
needed  
 
 
 

PS to PSSM HPUX 
Run SM9108J to 
post  
PS EmplID as 
alternate ID as 
well as update 
address with PS 
address 
 
Run SM9107J to 
post the email 
address from PS 
to FAM. 
 

Run FAF Load as 
usual. No change 
to program. 
 
 

 FAF Load ATB FAM Weekly  None 
needed 

 Run FAF Load as 
usual. No change 
to program. 
  

FAM Portal   FAM Daily  None 
needed 

Run SM9785J if 
college allows 
uploading of 
documents or 
accepting awards 
on the portal 

Process as usual. 
No change to 
program 

BankMobile Bio demo 
track code 

FAM Daily Yes, 
needed  
​
 

FAM to PS 
FAM Tracking 
Codes 
KW5001J 

Use KW5001J to 
extract roll-over 
and BankMobile 
tracking codes to 
create checklist 
items into PS. 
 
Schedule KW5001J 
to run on a nightly 
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basis to pull 
desired track codes 
from legacy then 
add to PS. 
 

Bank Mobile Bio demo 
extract file to 
Higher One 

PS Daily  None 
needed 

 PeopleSoft 
business as exists. 
No change to PS 
program. 

Tracking Letters   FAM 
(FAM056) 

Daily  None 
needed 

 Business as usual. 
No change to 
program. 

File 
Review/Eligibility 
Determination 

 Manual  FAM Daily  None 
needed 

 Business as usual. 
Note: Auto File 
Review process 
will be available to 
only check data in 
FAM.  Can run 
SM9141J (Ready to 
Review Report). 

Entrance Loan  Manual FAM Daily  None 
needed 

 Business as usual 

Exit Loan  Manual FAM Quarterly  None 
needed 

 Business as usual 

Awarding/Packagin
g 

  FAM 
(FAM610) 

Daily  None 
needed 

 Business as usual. 
No change to 
program. 

Award 
Notifications/Loan 
Debt Notifications 

  FAM 
(FAM010) 

Daily  None 
needed 

 Business as usual. 
No change to 
program. 

Pell COD 
 

FAM to COD 
Reporting 

FAM 
(FAM210​
FAM4116 
FAM4117 
FAM450) 
And HPUX 
SM9110J 
SM9111J 
SM9529J 

Weekly  None 
needed 

 Business as usual. 
No change to 
program. 
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Pell Eligibility 
Calculation​
(Eligibility 
Calculation) 

 FAM 
(FAM1317) 

Weekly None 
needed 

 Business as usual. 
No change to 
program. 

Pell COD  
(YTD Import & 
Payment Matching)  

YTD 
Reconciliatio
n Report 

FAM 
(FAM497 
FAM491) 

Monthly None 
needed 

 Business as usual. 
No change to 
program. 

DL COD FAM to COD 
reporting 

FAM 
(dlorig1617 
FAM8117 
FAM8217 
FAM210 
FAM8317 
FAM8517) 
And 
HPUX 
(SM9111J 
SM9529J) 

Weekly Yes, 
required 
 
 

PS to FAM: SULA 
data (CIP code, 
SULA Load, SULA 
length, SULA 
Type, Special 
Program Code) 

Business as usual. 
 
Depending on 
where imported 
SULA data is 
stored, may need 
to modify to read 
data from a 
different source. 

DL COD Monthly 
reconciliation 

HPUX 
(screen 
SM9120 
Batch job 
SM9119J) 

Monthly None 
needed 

 Business as usual. 
DLSAS file is 
uploaded to the 
HPUNX, using the 
existing upload 
process then the 
SM9119J program 
will read file. 
Process reads 
FAEXP tables. 

DL Disbursement 
Notifications 

  FAM 
(FAM056) 

Daily None 
needed 

 Business as usual. 
No change to 
program. 

Disbursement Auto App HPUX 
(FA095R) 
 

Daily No longer 
needed. 
 
 

 Will no longer be 
run since there will 
be no tuition and 
fees to pay off in 
FMS. 
 

Disbursement The former 
Check Calc 
process now 
becomes the 
Disburse-men
t Process 
 

HPUX 
(AG996R) 
and  
PS 
(Group 
Posting 
process) 
 

Daily Yes, 
required 
 
 

FAM to PS 
(SM9408 creates 
ZX110S2 file) 
 
PS to FAM 
(Units/credits 
attempted) 

(Enrollment 
information looked 
at from PSSM 
database then 
updates Academic 
Tab with units.) 
These 
disbursements are 
posted to FAEXP.  
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Preliminary 
disbursement 
job group 
AG905R can 
be run first to 
verify that all 
selected are 
ready to be 
disbursed. 

Student Financials 
will process the file 
through the 
PeopleSoft Group 
Post process. That 
process will apply 
disbursements 
included in the file 
and pay 
appropriate tuition 
& fees, then issues 
refunds as usual.  
File will contain 
upwards and 
downward 
adjustments. 
(Will be following 
up on SF 
Conversion 
activities to ensure 
FA payments from 
legacy are not 
being converted as 
the generic 1098T 
eligible/ineligible 
conversion item 
types. 
 

Disbursement Census Day 
Review 

HPUX 
(Data Express 
procedures 
SM9901R, 
SM9902R, or 
SM9903R) 

Quarterly Yes, 
needed 

PS to HPUX 
(enrollment data) 
Term/YrSess 
Units/Credits 
FA 
Load/Enrollment 
Level 

DataExpress 
procedures 
developed to pull 
students with 
census day 
information that 
colleges can use to 
identify changes in 
enrollment levels. 
Selected by Award 
Code/Sub Code 
and Track Code, 
Award Code/Sub 
Code or by Track 
Code 
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SAP  Process SAP HPUX 
 Data Express 
procedure 
SM9904R) 

Quarterly Yes, 
required 
 
 

PS to HPUX 
(enrollment data) 
Term/YrSess 
Units/Credits 
FA 
Load/Enrollment 
Level 
YrSess GPA 
Cumulative GPA 
 

DataExpress 
procedure 
SM9904R has been 
developed for this 
process.  

SAP SAP 
Conversion 

PS 
(SAP process) 

Quarterly Yes, 
required 
 
 

FAM to PS  
Conversion values 
exist in PS 
 

Student population 
pulled from FAM 
and Aid Year 
Activated, FA Term 
build and SAP run 
in PS 

R2T4  Manual Data 
reviewed in 
PS and 
entered onto 
Dept. of Ed 
R2T4 
worksheet or 
WSAC 
Repayment 
worksheet 

Quarterly None 
needed. 
 

 Business as usual. 
(Colleges will 
identify students 
from the SAP 
report or manually 
during the 
quarter.) 
 
 

Reconciliation​
 

FA vs FAEXP HPUX 
(SM9420J, 
SM9421J, 
SM9425J, 
AG941A and 
AG942A) 

Weekly    Run reconciliation 
reports as usual.  
Process is available 
to update FAEXP as 
needed. 

Reconciliation FAM FA vs PS 
Student 
Financials 

New step in 
business 
process 

Weekly Built PS to FAM: Pull 
FA item types 
from Student 
Financials for 
applied charges 
using existing PS 
query. Then will 
need a new query 
to reconcile FAM 
awards to 
PeopleSoft 
Student 
Financials data. 

Query used to 
compare disbursed 
values to posted 
values 
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Unit Record Report   HPUX 
(SM9110J 
SM9146J 
SM9108J 
SM9738J) 

Annually Yes, 
required 
 
  

PS to HPUX 
Enrollment data 
Ethnicity data 
 
 
Use current HPUX 
job to load the 
ethnicity into 
from PSSM fields 
(which the legacy 
URR program 
reads from)  

Business as usual 
for colleges.  

Washington College 
Grant IR and 
Washington College 
Grant Real Time 
Reporting 

  HPUX 
(SM9110J 
SM9739J) 

Quarterly 
& when  
Funds are  
Drawn 
from WSAC 

Yes, 
required. 
 
 
 

PS to HPUX 
Enrollment data, 
Bachelor degree 
data, and degree 
data included in 
PS files 

Business as usual 
for college. 
 

FISAP  FAM 
(FAM100) 
 
HPUX 
(SR1311J) 

Annually Maybe  Business as usual. 
No change to 
program. 
 
Query for 
Unduplicated 
headcount has 
been created. 

Work Study 
Reconciliation 

 HPUX 
(PSxxxxJ to 
compare 
manually 
against 
SM9425 or 
SM9420 
reports) 

Weekly Yes, 
needed 
 

PS to FAM 
Payroll earnings 
 
Possibly use 
existing work 
study HCM 
queries to pull 
data and load 
into FAM tables. 

Compare query 
used 

 

Business Process Changes 
Several current functions in processing financial aid in the legacy system will either change or not be 

available.   

 

1.​ Add New Student function in FAM – this process will no longer access SMS data and pre-enter 
biographic data.  A student can be added into FAM if they have not submitted a FAFSA.  However, 
all data will need to be entered manually.  You will first need to verify the student data is in PS 
before manually adding to the Student Data tab in FAM.  
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2.​ Colleges will not be able to copy student PINs from SMS into FAM using job SM9789J.  Colleges 
can configure FAM to enter the student’s birthdate as the PIN when the FAFLoad runs.   

a.​ Update Hours From Student System – The ability to update hours from SMS on the 
Academic Tab will no longer be available. 

 

3.​ BankMobile Bio Extract – The track code is converted to a PeopleSoft checklist item by running 
KW5001J.  That checklist item is completed by the Student Financials office and the Bio-Demo 
data for the student is sent to Bank Mobile. 
 

4.​ College will be expected to monitor exception reports produced by the data load process 
(AG995R). 
 

5.​ New educational programs.  If a college adds a new educational program after going onto PS , 
extra steps will need to be taken to ensure the correct data is posted.   
 

a.​ Add new program code to PS 
b.​ Add corresponding 3 or 4 character program code to SMS screen SM5006. 
c.​ Contact SBCTC ctcLink Customer Support to add both the new PS Prog Plan code and the 

EPC code to the crosswalk.  
 

6.​ It is recommended not to run the Final Award Disbursement Reconciliation that actually changes 
award amounts in FAM (AG942A).  To reduce errors, run the preliminary report (AG941A) and 
make manual adjustments. 

 
7.​ The Auto File Review job can be run during dual processing to check data that only exists in FAM.  

It cannot be run to check SMS data or Sponsorship data while in Dual Processing.  There is some 
setup required before the Auto File Review job can be run while in Dual Processing.   (See 
instructions on page 45)  
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Security Information for Dual Processing 
In order to complete the steps listed in this document, there are some security roles that Financial Aid 

and Student Financials staff need to have assigned to their Empl ID. Below are the navigations as well as 

the roles to be assigned. 

 

Financial Aid Roles: 

Nav Bar > Navigator > PeopleTools > CTC Custom > Extensions > Upload/Download Files 

●​ ZZ_FA_UPLOAD_DOWNLOAD 

Nav Bar > Navigator > Campus Community > CTC Custom > CTC Query Reporting Table 

●​ ZZ_CC_QRY_RPT_TBL 

Nav Bar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > FAM > FAM 

●​ ZZ_FINANCIAL_AID_MANAGEMENT 

 

Student Financials Role: 

Nav Bar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > FAM > FAM Disbursement Data 

Process 

●​ ZZ_FINANCIAL_AID_DISBURSEMENT 

 

Note: It is not recommended for a staff person to have access to both the FAM page as well as the FAM 

Disbursement Data Process page  
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Before you start 
The purpose of this guide is to get you familiar with the processes, navigations, and usage of validation 

queries. It details various steps needed to successfully run extracts, access queries and take any 

corrective actions (usage of validation queries and/or reports).  

A few recommendations when using the guide and understanding screenshots provided. 

●​ The parameters provided in the screenshots are for reference only. In PeopleSoft you have 

flexibility to select the  ‘Magnifying Glass’, next to most fields, to get all available parameter 
values. 

●​ Please read through the entire process details before starting a process to help you understand 

what results to expect as well as any pre-requisites/dependencies (if any).  

●​ Familiarize yourself with PeopleSoft acronyms and terminology (Glossary at the end of this 

guide) 

●​  
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Student Bio-Demo Data Extract 
This extract pulls bio/demo from PeopleSoft based on run control values.  The process pulls students 

who have enrollment based on the Start Term value.  When this process is run it will pull new and 

existing students for the indicated Start Term and onwards. 

​ ​ *The ”Start Term” value should be the first term of the award year. 

 

Pre-requisites 
●​ All dual processing crosswalks should be mapped including Acad Plan, Item Type, etc. 

 

Known Issues 
●​ The process may not run to Success because multiple primary ethnicities are linked to one 

student on the PS side. 

 

Bio/demo data with the latest effective dated row is extracted.  It will create the KWxxxBIO that will be 

loaded into HPUX. 

Navigation:  Nav Bar > Navigator > Financial Aid > CTC Custom > CTC Interface > FAM > FAM 

Enter a new or existing Run Control ID 

Enter the following data: 

1.​ The run control search page displays. 

2.​ Enter a valid existing Run Control ID, or Add a New Value for the Run Control ID. 

3.​ Select the Search button. 

4.​ The Joint Operations Data Interface page displays. 

5.​ Enter the Academic Institution. 

6.​ Enter the Start Term – value should be the first term of the award year. 

7.​ Select the Student Bio Demo Data checkbox. 

8.​ Select the Save button -- do not select Run; you will be building this process into a JobSet that 

will run this process and others in an overnight process. 

Note:  In the Term field, if you are a Header School, use the Summer Term in the Academic Year for 

which you are running Dual Processing.  If you are a Trailer School, use the Fall Term. If you do 

not use the Summer Term, for headers, or Fall Term for trailers, the process may not pick up 

essential records that need to be moved over to HPUX with this process. 
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Student Enrollment Data Extract 
This extract pulls Student Enrollment Data from PeopleSoft based on run control values.  Student 

Enrollment data with the most effective dated row for the indicated term is extracted.  The enrollment 

extract excludes enrollment with W grades. It will create the KWxxxENR that will be loaded into FAM.   

*The ”Start Term” value should be the first term of the award year 

 

Pre-requisites 
●​ All dual processing crosswalks should be mapped including Acad Plan, Item Type, etc. 

Navigation:  Nav Bar > Navigator > Financial Aid > CTC Custom > CTC Interface > FAM > FAM 

Enter a new or existing Run Control ID 

Enter the following data: 

1.​ The run control search page displays. 

2.​ Enter a Run Control ID. 

Be sure to create a new Run Control ID specific to this process.  Do not use the previous Run Control 

ID.  You will be using 4 unique Run Control IDs into a JobSet. 

3.​ Select the Search or Add button. 

4.​ The Joint Operations Data Interface page displays. 

5.​ Enter the Academic Institution. 
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6.​ Enter the Start Term – value should be the first term of the award year. 

7.​ Select the Student Enrollment Data checkbox. 

8.​ Select the Save button – do not select Run; you will be building this process into a JobSet that 

will run this process and others in an overnight process. 

 

      

Student Career Term/Quarterly Data Extract 
This extract pulls ALL Student Enrollment Data quarterly data from Peoplesoft for any student that has 

enrollment within the current financial aid year.  It will create the KWxxxQTR that will be loaded into 

FAM.  

*The ”Start Term” value should be the first term of the award year. 

 

Pre-requisites 
●​ Conversion data should be available for your school and for terms in the ctcLink PRD 

environment 

●​ All dual processing crosswalks should be mapped including Acad Plan, Item Type, etc. 

 

Navigation:  Nav Bar > Navigator > Financial Aid > CTC Custom > CTC Interface > FAM > FAM 

Enter a new or existing Run Control ID 

Enter the following data: 

1.​ The run control search page displays. 
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2.​ Enter the Run Control ID. 

3.​ Select the Search or Add button. 

4.​ The Joint Operations Data Interface page displays. 

5.​ Enter the Academic Institution. 

6.​ Enter the Start Term – value should be the first term of the award year. 

7.​ Select the Student Career/Term Quarterly Data checkbox. 

8.​ Select the Save button – do not select Run; you will be building this process into a JobSet that 

will run this process and others in an overnight process. 

 

 

 

Student Degree Data Extract 
This extract pulls ALL Student Degree Data from PeopleSoft. The term provided in the “Start Term” field 

is used to get the degree data for all the students awarded a degree in that term. It will create the 

KWxxxDEG that will be loaded into the HPUX clone database.   

*The ”Start Term” value should be the latest term for which degrees have been posted.  **Note, 

the Term should be updated each term this is run.   

 

Pre-requisites 
●​ All dual processing crosswalks should be mapped including Acad Plan, STRM, etc. 

Navigation:  Nav Bar > Navigator > Financial Aid > CTC Custom > CTC Interface > FAM > FAM 
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Enter a new or existing Run Control ID 

Enter the following data: 

1.​ The run control search page displays. 

2.​ Enter the Run Control ID. 

3.​ Select the Search or Add button. 

4.​ The Joint Operations Data Interface page displays. 

5.​ Enter the Academic Institution. 

6.​ Enter the Start Term – value should be the first term of the award year, AND should be updated 

each term after the confirmation of degrees by your Records and Enrollment dept. 

7.​ Select the Student Degree Data checkbox. 

8.​ Select the Save button – do not select Run; you will be building this process into a JobSet that 

will run this process and others in an overnight process. 

Note:  You MUST update this term-based run control each time your records office posts degrees for 

students.  This is the only Run Control for Dual Processing that you must update each term to 

capture graduated students for each term. 
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Create/Schedule Dual Processing JobSet (CTCFADP) 
This Jobset run all the extract processes in one overnight job in PeopleSoft. 

Each of the extract Run Control IDs will be embedded into the nested CTCFADP job list in the 

JobSet. 

 

Pre-requisites 
●​ All Run Controls for your outbound extracts (Bio Demo, Student Enrollment, Student Career 

Term, and Student Degree) should be built first. 

 

Navigation:  Nav Bar > Navigator > PeopleTools > Process Scheduler > Schedule JobSet Definitions 

Enter the following data: 

1.​ The Schedule JobSet Definitions search criteria page displays. 

2.​ select the Add a New Row tab if you are building this out for the first time. 

3.​ Enter the name of the desired Schedule Name. 

4.​ Enter the Job Name = CTCFADP 

5.​ Select Add (Or Search if using an Existing Run Control ID). 

 

 

 

6.​ The Schedule JobSet Definitions tab displays. 

7.​ Enter the Run Control ID -- it can match the name of the description already defined in the field 

above it. 
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8.​ Set the Status to Active -- this setting queues up the job to run as you set in the Time 

Information group box. 

9.​ In the Begin Date, note the date defaults to the day you are currently in.  In the Time field, select 

the Time that FA Support has assigned you as your nightly JobSet time. 

10.​ In the Recurrence Name, use the magnifying glass to define the time frame FA Support has 

assigned to you for this JobSet (i.e., M-F@2:00AM). 

11.​Set the Primary Server drop down option to Any Server. 

12.​Select the Schedule JobSet Items tab. 

 

 

 

13.​The Schedule JobSet Items tab displays. 

14.​Select the CTCFADP link to expand the fields on the page. 
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15.​The Process List group box displays. 

16.​Enter in each of the four fields the Run Control ID you created for each of the extracts.  i.e., 

●​ Enter the Bio Demo Data extract Run Control ID in the first field. 

●​ Enter the Student Enrollment Data extract Run Control ID in the second field.   

●​ Enter the Student Career Term Quarterly extract Run Control ID into the third field. 

●​ Enter the Student Degree Data extract Run Control ID into the fourth field. 

17.​Select Save. 
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CTCFADP JobSet Extract Validation Queries  
These series of validation queries can be run after you have successfully run the CTCFADP JobSet has run 

overnight.  The queries show the data generated and extracted to a file after a successful run of each 

extract. 

Run these validation queries when you come into the office each morning.  Check your Process 

Monitor to retrieve your Process Instance numbers to run in the query prompts. 

 

Tip!  The navigation to retrieve your Process Instance number in Process Monitor is:  Nav Bar > 

Navigator > PeopleTools > Process Scheduler > Process Monitor 

 

Bio-Demo Validation Query 
The Bio-Demo Validation query can be run after you have successfully run the Bio-Demo Data Extract 

process described above. This query shows the data generated and extracted to a file after a successful 

run of the Bio-Demo extract. 

 

Pre-requisites 
●​ The data extract process described in the previous step needs to be successfully run AND should 

have data generated. 

●​ Should have the ‘Process Instance’ number from the previous step. (Ref: Page 17 and follow 

steps). 

 

Known Issues 
●​ The query generates no results: 

o​ The Process Instance number provided was run by another user. 

o​ The file generated when running the extract process in the previous step contains no 

data.  

 

Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query 

Enter a new or existing Run Control ID 

Enter the following data: 

●​ Query Name - CTC_FA_I111_BIODEMO_VALIDATION 

●​ Institution 

●​ Process Instance Number (Use the Process Monitor to retrieve your Process Instance Number) 

●​ Select Run 

Note!—To update your Run Control ID each day with the new Process Instance number, detail in to the 

Update Parameters link (highlighted in the image below) to update your Edit Prompts. 
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From the Process Scheduler Request page ensure the PSQUERY box is checked 

Select OK 

 

When returned to the Schedule Query page select Process Monitor 

From the Process Monitor page select Details link 
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From the Process Detail page select the View Log/Trace link 
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Select the CTC_FA_I111_BIODEMO_VALIDATION-xxxxxxx.csv link will open and Excel Spreadsheet for 

review. 
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Student Enrollment Validation Query 
The Student Enrollment Validation query can be run after you have successfully run the Data Extract 

process described above. This query shows the data generated and extracted to a file after a successful 

run of the extract above. 

 

Pre-requisites 
●​ The data extract process described in the previous step needs to be successfully run AND should 

have data generated. 

●​ Should have the ‘Process Instance’ number from the previous step. (Ref: Page 23 and follow 

steps). 

 

Known Issues 
●​ The query generates no results: 

o​ The Process Instance number provided was run by another user. 

o​ The file generated when running the extract process in the previous step contains no 

data. 

 

Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query 

Enter a new or existing Run Control ID 

Enter the following data: 

●​ Query Name - CTC_FA_I121_SDNTENR_VALIDATION 

●​ Institution 

●​ Process Instance Number (This is acquired from the previous process) 

●​ Select Run 

Note!—To update your Run Control ID each day with the new Process Instance number, detail in to the 

Update Parameters link (highlighted in the image below) to update your Edit Prompts. 
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From the Process Scheduler Request page ensure the PSQUERY box is checked 

Select OK 

 

From the Process Monitory page select Details 
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From the Process Detail page select View Log/Trace link 

 

 

Select the CTC_FA_I121_SDNTERN_VALIDATION-xxxxxxx.csv link. An Excel Spreadsheet will open for 

review. 
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Student Career Term Validation Query 
The Student Career Term Validation query can be run after you have successfully run the Data Extract 

process described above. This query shows the data generated and extracted to a file after a successful 

run of the extract above. 

 

Pre-requisites 
●​ The data extract process described in the previous step needs to be successfully run AND should 

have data generated. 

●​ Should have the ‘Process Instance’ number from the previous step. (Ref: Page 33 and follow 

steps). 

 

Known Issues 
●​ The query generates no results: 

o​ The Process Instance number provided was run by another user. 

o​ The file generated using the Process Instance number provided when running the extract 

process in the previous step contains no data. 

 

Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query 

Enter a new or existing Run Control ID 

Enter the following data: 

●​ Query Name - CTC_FA_I112_SDNTCAR_VALIDATION 

●​ Institution 

●​ Process Instance Number  

●​ Select Run 

Note!—To update your Run Control ID each day with the new Process Instance number, detail in to the 

Update Parameters link (highlighted in the image below) to update your Edit Prompts. 
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From the Process Scheduler Request page ensure the PSQUERY box is checked. 

Select OK 

 

From the Process Monitor page select Details 
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From the Process Details page select View Log/Trace 

 

 

From the View Log/Trace page select the CTC_FA_I112_SDNTCAR_VALIDATION-xxxxxxx.csv link 
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Student Degree Validation Query 
The Student Degree Validation query can be run after you have successfully run the Data Extract process 

described above. This query shows the data generated and extracted to a file after a successful run of 

the extract above. 

 

Pre-requisites 
●​ The data extract process described in the previous step needs to be successfully run AND should 

have data generated. 

●​ Should have the ‘Process Instance’ number from the previous step. (Ref: Page 40 and follow 

steps). 

 

Known Issues 
●​ The query generates no results: 

o​ The Process Instance number provided was run by another user. 

o​ The file generated using the Process Instance number provided when running the extract 

process in the previous step contains no data. 

 

Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query 

Enter a new or existing Run Control ID 

Enter the following data: 
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●​ Query Name - CTC_FA_I123_STDNDEG_VALIDATION 

●​ Institution 

●​ Process Instance Number  

●​ Select Run 

Note!—To update your Run Control ID each day with the new Process Instance number, detail in to the 

Update Parameters link (highlighted in the image below) to update your Edit Prompts. 

 

 

From the Process Schedule Query ensure the PSQUERY box is checked 

Select OK 

 

 

 

When returned to the Schedule Query page select Process Monitor 
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From the Process Monitor page select Details 

 

 

From the Process Detail page select the View Log/Trace link 

      

 

From the View Log/Trace page select the CTC_FA_I123_STDNDEG_VALIDATION-xxxxxxx.csv link 

This will open an Excel Spreadsheet for review.  
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Processing the Extract Files in Legacy 
When scheduling the Dual Processing HPUX jobs, please follow the process outlined in the sections below.  When 

you schedule an HPUX batch job that produces a report or reports, please enter ‘Y’ in the D (for Deferred) field in 

the Report section.  The report will not automatically be sent to your campus software where you normally get 

your HPUX job reports.  When you do run a job, you will need to enter a request in OTM and the report will be 

provided for you.  
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AXWAY 

The files generated in PeopleSoft application are transferred every 30 Mins to HPUX through AXWAY 
connection. Please ensure all the PS reports are transferred before running AG995R Job. 
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AG995R – Job Group  
This job group loads the data contained in the PS files into the cloned PSSM, PSTRAN, and PSCA 

databases.  

 

Pre-requisites 
●​ All PeopleSoft outbound extracts listed below should have been successfully run: 

o​ Student Bio-Demo 

o​ Student Enrollment 

o​ Student Career Term/Quarterly  

o​ Student Degree 

●​ Each file generated by PS Outbound extracts should have been picked by Axway (Ref: Page 49) 

and moved to legacy. 

 
In preparation to load the files, the first 4 jobs in the job group erase data from the PSSM, PSTRAN and 

PSCA databases so that the new data from PS can be loaded.  Note:  the individual jobs in this job group 

are discussed below.  However, do not schedule these jobs individually.  Always schedule the complete 

AG995R job group. 

●​ KW0005J – Erase PSSM 

●​ KW0006J – Erase PSTRAN 

●​ KW0007J – Erase PSCA 

●​ KW1050J – Load/Unload Datasets 

 

The files are then loaded into the PSSM, PSTRAN and PSCA databases by the last 4 jobs in the job group.  

Each job loads one of the file’s data.  Each job produces a report that either indicates records that could 

not be loaded or records with an error or warning situation. 

The jobs run in the following order. The PS extract files are posted in this order also. 

KW1010J – PeopleSoft to SM Load – this job loads the biographic file from PS.   

KW1030J – FAM/ctcLink Stu Quarterly Load – this job loads the quarterly file from PS. 

KW1020J – FAM/ctcLink Enrollment Load – this job loads the enrollment file from PS. 

KW1040J – PeopleSoft to TRAN-DEGREE-D Load – this job loads the degree file from PS. 

Note:  the individual jobs in this job group are discussed below.  However, do not schedule these 

jobs individually.  Always schedule the complete AG995R job group. 

 

Post Go-Live Process 
The Legacy Production Support team and ctcLink FA Support will work with your college’s team to 

schedule the AG995R job to run daily.  The job will load the incoming data for active students for current 

term only. Any students having future effective dated rows will not get loaded by the process and show 
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up on the error report. The job will pick up active students’ data with effective dates falling within the 

current term only. 

 

Scheduling AG995R 
This job group needs to run after the PS files have been loaded onto the HPUX by a software called 

Axway.  Sufficient time is needed between when the files are created in PS and when Axway loads them 

onto your HPUX.   You will be informed on how often Axway runs and can move the files from PS and 

also move files created by processes on the HPUX. 

There are no job scheduling parameters for this job group. 

​ Again, schedule the complete job group and not the individual jobs in the job group. 
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Reports 
 

KW1010R 
This report list the student’s PS EMPL ID, Name and Exception Message if the record had an error.  If 

there are no errors, no students appear on the report and a message appears indicating no exceptions 

were found. 

Example of the KW1010R report where no errors or exceptions were encountered. 

 

 

Exception and Error conditions – the following error messages will display on the report 

with the invalid value in the file after the error message.  These errors need to be resolved 

before the records can be loaded into the cloned databases on the HPUX used in Dual 

Processing. 

 

"INVALID SEX” - the Sex code is not blank, ‘M’ or ‘F’                     

“INVALID CITZ-STAT” - the Citizenship Status Code is not a valid system code      

"INVALID CENSUS-HISP-CD” - the Census Hispanic Code is not a valid system code           

"INVALID CENSUS-RACE-CD” – the Census Race Code is not a valid system code                     

"INVALID CENSUS-RACE-CD2” – the Census Race Code 2 is not a valid system code           

"INVALID FEE-PAY-STAT” – the Fee-Pay-Status Code is not a valid system code           

"INVALID ETH-ORIG” – the Ethnic Origin Code is not a valid system code                         

"INVALID RES-STAT” – the Residency Status Code is not a valid system code           

 

KW1020R 
This report list the student’s PS EMPL ID, Name, YRQ and Exception Message if the record had an error.  

If there are no errors, no students appear on the report and a message appears indicating no exceptions 

were found. 
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Example of the KW1020R report where errors or exceptions were encountered. 

 

 

Exception and Error conditions – the following error messages will display on the report with the 

invalid value in the file after the error message.  These errors need to be resolved before the records can 

be loaded into the cloned databases on the HPUX used in Dual Processing. 

 

"INVALID YRQ” - the YRQ code is not a valid YRQ code                     

“INVALID SID” - the SID does not have a corresponding biographic record in the PSSM database      

"INVALID GR” – the Grade Symbol is not a valid Grade Symbol code on the Grade Attribute Table 

"NO STU-YRQ-M FOR " – the student does not have a quarterly record for the quarter listed after their 

EMPL ID         

 

NOTE: Most errors on KW1020R report are caused by the student load errors on KW1030R (read 

below). Once you clear out errors on KW1030R, the errors on KW1020R report get resolved as 

well. 

 

KW1030R  
This report list the student’s PS EMPL ID, Name, YRQ and Exception Message if the record had an error.  

If there are no errors, no students appear on the report and a message appears indicating no exceptions 

were found. 

 Example of the KW1030R report where errors or exceptions were encountered. 
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Exception and Error conditions – the following error messages will display on the report with the 

invalid value in the file after the error message.   

 

"INVALID YRQ” - the YRQ code is not a valid YRQ code                     

“INVALID SID” - the SID does not have a corresponding biographic record in the PSSM database      

"INVALID RES-STAT” – the Residency Status Code is not a valid system code           

“INVALID CITZ-STAT” - the Citizenship Status Code is not a valid system code      

"INVALID STU-INT” - the Student Intent Code is not a valid system code           

"STU-PRG-ENR: xxx NOT IN EDUC-PRG-M OR PRG-INVEN-M” – the Education Program Code in the file 

does not have a corresponding SMS entry          

 

Note 1: Resolving errors on this report also resolves student load errors on KW1020R report. 

Note 2:  For the error "STU-PRG-ENR: xxx NOT IN EDUC-PRG-M OR PRG-INVEN-M” below resolutions will 

need to be performed to correct these types of errors:  

✔​ “STU-PRG-ENR: XXX NOT IN EDUC-PRG-M OR PRG-INVEN-M”: This error shows up 

because students are enrolled in an academic plan in PeopleSoft system that do not 

have a corresponding EPC value mapped in Dual Processing crosswalk.  

o​ Resolution: You can ask the FA Support team to give you the list of Acad Plans 

that might be causing this error. Once these Acad Plans deltas that don’t have 

any EPC, are mapped in PeopleSoft Dual Processing crosswalk, You will need to 

re-run all the outbound jobs and AG995R again.   

✔​ “STU-PRG-ENR: UNDE NOT IN EDUC-PRG-M OR PRG-INVEN-M”: When the ‘XXX’ is 

replaced by a specific EPC means that there exists a valid Acad Plan to EPC crosswalk but 

that EPC is not recognized on the Legacy side. This could be because of a couple of 

reasons: 
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o​ A new EPC was assigned for the purpose of Dual Processing Acad Plan to EPC 

crosswalk but has not yet been added to the SM5006 Screen.  

o​ The new EPC was created and added under the SM5006 Screen but under ‘P’ 

account. 

o​ The student could be enrolled in a non-FA eligible program (TRNST) Transitional 

Studies Acad Plan, and it is not mapped to an EPC in Legacy. 

In the above example: ‘UNDE’ (Undecided) EPC code is not added to the SM5006 

screen.  That is why all students whose PeopleSoft Academic Plan is mapped to 

‘UNDE’ EPC are showing up in the error report. This EPC needs to be added to the 

SM5006 database in the Prod (‘P’ Account) to resolve these errors.  

Resolution: Please coordinate with your records team to have these plan codes 

and/or relevant details added to SM database. 

 

KW1040R 
This report list the student’s PS EMPL ID, GRAD YRQ and Exception or Warning Message if the record had 

an error or has an Exit Code that is not looked at by the SNG-IR job (SM9739J).  If there are no errors, no 

students appear on the report and a message appears indicating no exceptions were found. 

 

 

 

Error and Warning conditions – the following error or warning messages will display on the 

report with the invalid value in the file after the error message.  These errors need to be resolved before 

the records can be loaded into the cloned databases on the HPUX used in Dual Processing. 

 

"EMPLID = SPACES. RECORD: “– the record in the PS file has a blank EMPL ID 

"GRAD-YRQ = SPACES. RECORD: “– the record in the PS file has a blank Grad YRQ 

"WARN-INVALID EXIT-CD:  NOT A-Y OR 1; RECORD WAS LOADED” – the record has an Exit Code that is not 

A through Y or 1 but was loaded into PSTRAN database.    

“GREATER THAN 9 DEGREES FOR: “ – the student has more than 9 degrees or certificates. 

 

49 | Page 
May 23, 2022 



FA Dual Processing 
 

Note 1: Most errors occurring on this report are informational warnings that can be ignored. The degree 

records almost always load, albeit with warnings. No additional actions are required to resolve warnings. 

FAS HPUX Batch Jobs  
These HPUX batch jobs are available to run during Dual Processing 

Process ID Job Group  Title 

SM9097J  19-20 Automatic File Review **has limitations 

SM9101J  Admissions Status Update 

SM9103J AG903R Academic Progress Report  

SM9104J  Finaid Excessive Credits Report 

SM9105J  FAM Academic Interface Update 

SM9107J  Import Email Addresses into FAM 

SM9108J  Finaid Biographic Update from SMS 

SM9109J  Finaid Funded Hours Update 

SM9110J  Finaid Attempted Hours Update 

SM9111J  FAS Academic Enrolled Program Data Update 

SM9117J  Post EFD Tracking Codes and Report 

SM9118J  Col Bound Scholarship File Rpt/Upd 

SM9119J  Dir Loan Reconciliation Report 

SM9141J  Faid Ready for Review Report 

SM9146J  Post SM Grade Level to Faid/Credit 

SM9407J AG905R Finaid Prelminary Check Calc Extract 

SM9405J AG905R Finaid Check Calc Prelminary 

SM9409J  Finaid Session Enrollment Codes Update 

SM9412J  Correct SSN in FAEXP Report/Update 

SM9420J  Annual Award Disbursement Report 

SM9421J  Quarterly Award Disbursement Report 

SM9425J  Financial Aid Expenditures Report 

SM9430J AG941A Extract Award Disbursement Discrepancies 
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SM9431J AG941A Preliminary Award Disb Recon/Update 

SM9529J  Recon Data Change for Pell/DL Rpt 

SM9702J  NSLDS Batch Monitoring Extract 

SM9738J  Unit Record Report 

SM9739J  WCG IR 

SM9785J  FAM Portal Action Required Report 

 

 

Auto File Review While in Dual Processing 
The Auto File Review process (SM9954J for 18-19; SM99054J for 19-20) looks at data elements 

in FAM as well as in SMS and FMS (sponsorships) to aid in determining the eligibility of a 

student to receive financial aid.   

In Dual Processing, the data in FMS and SMS data will not be updated.   However, the data in 

FAM will continue to be updated until the college is no longer on Dual Processing. 

If a college in Dual Processing wants to continue to run Auto File Review, they may do so to 

check data in FAM ONLY.    

There are several items that will need to be changed or modified in FAM to have AFR run 

successfully while a college is in Dual Processing. 

1.​ You will need to disable the CIS/WRV Processing Table entries that check data in the SM 

database and in the Sponsorship database.  To disable these entries remove whatever is 

in the description field.   These are:   
 

BA-IN-SMTRK 

CITZINSM 

ELIGSTUINTENT 

INELIGPRG1 through INELIGPRG5 

INELIGPRGTRK 

INELIGSTUINTTRK 

NONRESFEEPAYTRK 

PRCOLSMTRK 

PRCOLTRNSFRTRK 
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RESFEEPAY 

SPONSORTRK 

You will need to keep your track code and notation code for the following two entries 

since they cannot be disabled: 

NOSMSTRK 

NOSMSYRQTRK 

 

2.​ Change the descriptions for the track code or track codes entered in the NOSMSTRK and 

NOSMSYRQTRK values.  Since these edits cannot be disabled, change the descriptions to 

something like ‘Disregard’ as the short description and ‘Disregard; Not a Valid Edit’ for 

the long description.   

To change the descriptions for a track code go to Application Setup; Validation Table.  

Type in SAF_TRACK_CODE in the Table Name field, select Search, and then select the 

edit icon.  Locate the track code and select the edit icon.  Change the Short Description 

and the Long Description.  Select Save & Go Back when done. 

 

Example: 

 

 

3.​ Schedule a new instance of AFR (SM9054J for 19-20) and delete any you have scheduled 

on a recurring basis.   When scheduling the new instance, enter ‘N’ in the following job 

scheduling parameters: 

NON-SMS-EXCLUDE 

Z-AGENCY-SPONSOR 

Z-BA-DEG-SM 

Z-INVALID-INTENT 

Z-INVALID-PROG 

Z-NON-CITZ-SM 

Z-NONRES-FEE-PAY 

Z-PR-COL-TRNSFR 

Z-PRIOR-COL-ADM 
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Z-PRIOR-COL-SM 

 

The AFR job will check to see if the student has a record in the SM database because of the edit 

that cannot be disabled.  If the student is not in the SM database before converting to 

PeopleSoft, they will appear on the report with the new description of the track code that 

entered for CIS/WRV Processing Table entries NOSMSTRK and NOSMSYRQTRK.   

 

SM9954A Example: 
In this example, the 1st and 3rd students are not in SM so have been assigned the track code entered on 
NOSMSTRK and NOSMSYRQTRK.  This track code now has a description of ‘Disregard; not a valid edit’ 
which indicates it can be ignored.    The 2nd student is in the SM database so is not assigned the track 
code entered on NOSMSTRK and NOSMS 

 
 

SM9954b Example: 
In this example, the 2nd student is not in SM so have been assigned the track code entered on 
NOSMSTRK and NOSMSYRQTRK.  This track code now has a description of ‘Disregard; not a valid edit’ 
which indicates it can be ignored.    The 1st student is in the SM database so is not assigned the track 
code entered on NOSMSTRK and NOSMSYRQTRK. 
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Sample CIS/WRV Processing Table: 
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Processing Rollover and Bank Mobile Track Codes (FAM) 
HPUX Batch Job KW5001J creates a file of Track Codes that is automatically sent to PS to be converted to 

Checklist Items when the PS Rollover Checklist process is run. 

 

KW5001J Job Scheduling Parameters: 

●​ KW5001 - BEGYRQ - Enter the year/session of records you wish to extract.   For example C013.  

You can enter a range of quarters by entering in a different year/session in the KW5001-ENDYRQ 

parameter 

●​ KW5001-BM-TRK - Enter in the BankMobile track code used at your college.  

o​ This field can be left blank if you do not submit records to BankMobile.   

●​ KW5001-COMP-DATE –Enter in the Completion Date of the rollover Track Codes to be included 

in the file. This date defaults to the current date but can be changed if run for a specific date in 

the past.  When this job is scheduled on a daily basis, this date will increment to the next day.  

(format YYMMDD) 

●​ KW5001-ENDYRQ – enter the ending year/session of the records you wish to extract.  In most 

cases, this entry will be the same as entered in KW5001-BEGYRQ. 

●​ KW5001-RPT-SORT – Enter N to sort the reports by student’s name; enter S to sort the reports 

by SID.    

●​ KW5001-TRK-CDS1 through K25001-TRK-CDE6 - Enter up to 180 rollover Track Codes to be 

selected.  Enter 30 Track Code per line with no space or commas between them. Example: 

38AST9.  

 

Besides creating the file that is automatically sent to PS, the job produces two reports.  One is a list of 

students that were included in the file and the other is a list of students where there were errors.  

Students with errors are not included in the file. 

 

KW5001A – Tracking Codes to Check List Item Extract.  This report contains a list of students who were 

extracted and included in the file.   

  

 

KW5001B – Tracking Codes to Check List Item Extract Error Report.  This report contains a list of students 

who had errors and were not included in the file.   
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Regenerating Rollover and BankMobile Track Codes from Legacy 
The track code to checklist interface will only process a single file at a time. If multiple files are sent over, 
the previous file will be overwritten by the newest file. If the staff person responsible for running the 
track code to checklist interface is out of the office, the KW5001J job should be stopped. In the event the 
job continues to produce files and staff are not running the PS side of the process, these rollover and 
BankMobile track codes may be resent.  
 

To resend the BankMobile track codes, simply remove the completion date on the BankMobile track 
code. These will be resent the next time KW5001J runs. 
 
There are two options to get the rollover track codes regenerated for the purposes of Dual Processing: 

1)​ The completion date for the records can be changed to a future date, such as the following date. 
These track codes would then get picked up with that night’s KW5001J. 

2)​ Alternatively, the KW5001J can be scheduled for the date the job ran without the PS interface 
processing. When you schedule the KW5001J for the date missed, you will run the job 
immediately. Once the file has been created and sent to PS, run the PS interface. If there is more 
than one date that was missed, you will run through the process of scheduling the KW5001J for 
the specified date and running the PS process until all missed rollover track codes are resent. 
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Processing Checklist Items (PeopleSoft) 
This process will retrieve the file that was created and sent to the PeopleSoft server. Only one file can be 

retrieved at a time. 

 

Pre-requisites 
●​ The KW5001J job described above should have been run and the file that is generated takes 5-10 

mins to move over to PeopleSoft. Wait at least 5 mins before proceeding with the steps below. 

●​ All dual processing crosswalks should be mapped including Acad Plan, Checklist Code, Checklist 

Item, Admin Function, etc. 

 

Navigation:  Nav Bar > Financial Aid > CTC Custom > CTC Interfaces > FAM > FAM 

Enter a New or Existing Run Control ID 

From the Joint Operations Data Interface page enter the following information: 

●​ Academic Institution – Select lookup to choose your institution. 

●​ Start Term 

●​ Select Tracking Codes 

●​ Select Run 

 

 

From the Process Scheduler Request page ensure Peoplesoft to FAM Integration is selected. 

Select OK 
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Once directed back to the Joint Operations Data Interface page select the Process Monitor link 

 

 

From the Process Monitor page ensure the process has run to Success and Posted 

Select the Details link 
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From the Process Detail page select the View Log/Trace link 

 

From the View Log/Trace page select the CHECKLIST-xxxxxx.log link to view processing details 
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The Interface Log will open 

 

61 | Page 
May 23, 2022 



FA Dual Processing 
 

Checklist Validation Query 
The checklist validation query can be run after you have successfully run the extract process described 

above. This query shows the data loaded after a successful run of the extract above. 

 

Pre-requisites 
●​ The data extract process described in the previous step needs to be successfully run AND should 

have data generated. 

●​ Should have the ‘Process Instance’ number from the previous step. 

 

Known Issues 
●​ The query generates no results: 

o​ The Process Instance number provided was run by another user.  It is recommended one 

user run the entire process end-to-end. 

o​ The file generated using the Process Instance number provided when running the extract 

process in the previous step contains no data. 

 

Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query 

Enter a new or existing Run Control ID 

Enter the following data: 

●​ Query Name - CTC_FA_I117_TRKCODE_VALIDATION 

●​ Process Instance Number (This number is acquired from the previous process—you may also 

select the Look Up Tool to find the most recent instance number) 

●​ Select Run 
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From the Process Scheduler Request page ensure the PSQUERY box is checked 

Select OK 

 

When returned to the Schedule Query page select Process Monitor 

From the Process Monitor page select the Details link 

 

 

From the Process Detail page select the View Log/Trace link 
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Select on the CTC_FA_I117_TRKCODE_VALIDATION-xxxxxxx.csv link and open an Excel Spreadsheet for 

review.  
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●​ The I-117 track code validation query can be used to compare against the KW5001A report to 

confirm all track codes from legacy have been pushed into PS 

Disbursement (FAM) 
The disbursement will be calculated in FAM.  That information is loaded into PeopleSoft and the 
disbursement is processed there.  This process is for all funds to be disbursed to pay tuition and fees and 
for a refund check which is new with Dual Processing.  
 
 
Here are the steps: 

1.​ Student is awarded in FAM 
2.​ When ready to disburse, college runs job groups AG905R & AG996R.   

 
 
 
The new AG996R job group contains the following jobs: 

a.​ SM9407J (FA Check Calc Extract) 
b.​ KW9408J (FA Check Calc Update) 
c.​ SM9099J (Purge FA Extract File)  

3.​ AG996R posts the check calc track code into FAM which now indicates that a disbursement was 
calculated  

4.​ AG996R also updates the FAEXP database with the disbursed amount. 
5.​ Additional Jobs: 

a.​ SM9407J (Rejected Checklist) 
b.​ KW9408J/SM9405J (Pending Checklist) 

6.​ The KW9408J job creates a file of the total amount to be disbursed for each student extracted 
a.​ File automatically goes over PS   
b.​ File is loaded into PS via the PS Group Post process. 

7.​ Tuition is then paid and the balance refunded to the student. 
 

Note:  the student’s enrollment level is still checked against the PSSM cloned database and the editing 
for paid tuition is disabled in this job group. 
 

Award Adjustments 
 
It is recommended that refund hold service indicators are placed on student accounts while they are in 

the process of having aid adjusted.  

 

If swapping aid, send over the reduced or fully zeroed – out aid in one disbursement file that will be 

posted to PS first.  

Then send over the new or replacement aid in a separate batch after the initial batch is fully processed.  

 
1.​ Student’s award is adjusted in FAM. 
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a.​ Increase or decrease the award amount in FAM.  Do not change the Award Status from 2 
or your alternate award status. 

b.​ Change the CC track code to a different track code 
 

2.​ College runs new job group AG996R (you can run the preliminary AG905R first to review the 
adjustment) 

i.​ AG996R adjusts FAEXP  
ii.​ AG996R posts the CC track code with the adjust amount entered in the 

Comment field.   
3.​ Adjustment is entered in file that goes to PS 
4.​ File is loaded into PS via the FAM Data Disbursement Process – which serves as a dual processing 

group post. 
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Disbursement (PeopleSoft) 
The disbursement process is built to retrieve the created file from the PeopleSoft servers.   

It is recommended that this process be run by the Student Financials office. The processing pulls the 

disbursement file produced by the Financial Aid users (after running AG996 Job from previous step) and 

creates a Group Post which posts Financial Aid to the student’s accounts.  

 

Pre-requisites 
●​ The data extract process described in the previous step needs to be successfully run AND should 

have data files generated. 

●​ Recommended to wait for a couple of minutes before running the PeopleSoft process after 

running AG996R Job described in previous step, as the files generated might take some time to 

be uploaded and be available for PS processing. 

●​ User running this process should have Student Financials related role to access the menu. 

 

Known Issues 
●​ The navigation is not available: 

o​ The user trying to access the navigation does not have a proper security role to run the 

process. Please contact your local security administrator at the college. 

●​ There are no files available to select when selecting ‘Select Files’ for individual processing: 

o​ The legacy job recently completed and might still be transferring the file to PS File 

servers. Wait a couple minutes and then refresh/re-navigate to the run control page. 

●​ Process Monitor shows ‘No Success’: 

o​ There are no files available for processing. Wait a couple minutes and then re-run to the 

process. 

 

Navigation:  Nav Bar > Financial Aid > CTC Custom > CTC Interfaces > FAM > FAM Disbursement Data 

Process 

Enter New or Existing Run Control ID 

From the FAM Disbursement Data Process page enter the following: 

●​ Academic Institution 

The FAM Disbursement Data Process page has some run option choices.  

By selecting Use System Date, the process will automatically pick up the current date file. 

By unselecting Use System Date the Select Files link will become available.  This feature allows users to 

choose which file to process first if multiple files are waiting to be processed. 

*Please Note* 

Disbursement files are REQUIRED to be processed in sequential order 
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Once files are selected or Use System Date is selected select Run.   

Tip! Uncheck “Use System Date” first to see if there are any older files that need to be processed first.  

Choose the “Select Files” link to review for older files. 

 

From the Process Scheduler Request page ensure the FAM Disbursement Data Process box is checked 

Select OK 

 

 

Once directed back to the FAM Disbursement Data Process page select Process Monitor 
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From the Process Monitor page ensure the process runs to Success and Posted 

Select the Details link 

 

From the Process Detail page select on the View/Log Trace link 
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From the View Log/Trace page select the PS_FAM_Check_Data_Process_Summary_Log_xxxxxxxx.txt 

link 

 

The PS FAM Disbursement Check Data Summary Log will open with details on the processing 
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*Please Note* 

Student Financials security is required to access the above navigation. 

 

SF Pages used for reviewing posted data: 
 

*Please Note* 
Student Financials security is required to access these navigations. 

 

Group Processing Review Transactions Page 
Navigation:  Nav Bar > Student Financials > Charges and Payments > Group Processing > Review 
Transactions 
Users will need the Group ID found in the Log file (example highlighted in image above) 

 

View Customer Accounts 
Navigation:  Nav Bar > Student Financials > View Customer Accounts 
Users will need the Business Unit (Academic Institution) and an Empl ID for a student 
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Processing Disbursements for Students with No Enrollment on PS Side 
There are two different methods to use when you need to disburse or adjust financial aid funds for 

students who are no longer enrolled.  Which method to use is dependent on the student’s record in 

PeopleSoft.  If the student is no longer enrolled for any quarters in PeopleSoft and their bio/demo record 

is not coming over from PeopleSoft, follow the first method.  If the student had enrollment for prior 

quarters during Dual Processing and their bio/demo record is coming over from PS, follow the second 

method.  

First Method:  Students were awarded in FAM but no longer have enrollment.   
These students are receiving the error message of “Student is not in the Student Management System” 

on the Financial Aid Rejected Checklist (SM9407) report and their disbursement cannot be sent over to 

PeopleSoft. 

In these situations, Student Financials will be required to manually enter the transactions to Customer 

Accounts.  Follow the steps below: 

 

Navigation:  Nav Bar > Student Financials > View Customer Accounts 
 

1.​ Identify the Payment ID by looking at the student’s customer account for the specified award 

and term. Make a note of the Payment ID and the amount in the first line under the details 

section. 
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2.​ Create a Group Post. Populate the first tab with the following information.  The accounting date, 

received date, and entry date are up to you to determine which date you would like to use. The 

control totals do not need to be populated for this group post.   

 

Navigation:  Nav Bar > Student Financials > Charges and Payments > Group Processing > Create Group 
Data Entries 
 

 

 

 

3.​ On the second tab, enter the student id, the account type of TUT, the item type, and the 

effective date for the award needing adjustment.   

 

4.​ Once the item type is populated, the Payment ID field becomes available.  This is where you will 

enter the payment ID from step 1. Notice the item amount and term are auto populated with 

the dollar amount from step 2 and the fields are grayed out when you enter a Payment ID.  Using 

the Payment ID allows for us to use specific information in the system related to financial aid 

item types to reverse/reduce amounts with. 

 

5.​ Repeat as needed by selecting the (+) plus sign in the top right-hand corner.  Once the entries 

are complete, select SAVE. You will notice the Group ID change from NEXT to a number. Copy the 

number as it is needed to complete the posting process. 
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6.​ Navigate to the Post Transactions page and post your Group ID. Select SFPGRPST from the list of 

processes to run.  

Navigation:  NavBar > Navigator > Student Financials > Charges and Payments > Group Processing > 

Post Transactions 

 

7.​ Once the process has run to SUCCESS and POSTED, check the student’s customer account. You 

should see a complete reversal of the total award amount. 
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8.​ To enter the amount the student is eligible for currently, you will create another group post but 

this time adding in the specific dollar amount and the term.  We recommend adding a reference 

number so we know these transactions were part of the dual processing no enrollment 

corrections. The first tab, Group Entry, is populated the same as step 2 above. 
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9.​ Once the entries are completed, click SAVE and run the Post Transactions process again. 

10.​When you have SUCCESS and POSTED for the Post Transactions, verify the student’s customer 

account is correct by looking at the Amount and the last line of details for the specific award. 

 

Updating FAEXP 

Once PS has been adjusted, the FAEXP database needs to be adjusted.  Follow the attached instructions 

to update FAEXP.  You will use the attached spreadsheet to enter the disbursements or adjustments and 

will upload it to the HPUX using screen SM9503.  You may need to have your Application Security 
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Manager add this screen to your HPUX menu.  Once the spreadsheet has been uploaded to the HPUX, 

job SM9503J will post the information from the spreadsheet to the FAEXP database. 

 

 

Second Method:  Bypassing Enrollment Edit in AG996R for Non-Enrolled Students (CARES, 
Emergency Funding)   

You can bypass the Rejected Checklist edit of ‘Student is not enrolled for this Year/Quarter’ for students 

where their enrollment is not coming over from PeopleSoft either because the student is no longer 

enrolled or the student is enrolled in classes that are not included in the Student Enrollment Data Extract 

but have a biographic record coming over from PS.    This allows you to disburse to students receiving 

this edit though the automated process. 

To activate the bypassing of the enrollment, edit, you will need to assign a designated Track Code to the 

student’s Tracking Tab in FAM for the same quarter you are disbursing.  The specific Track Code is 

established on a Processing Table entry.   This entry may already be on your Processing Table. 

System:                 CIS           

Table ID:              WCC 

Value:                   SM9407-OVERRIDE   

Description:        Two character Track Code (must exist on the SAF_TRACK_CODE Validation Table)    

  

 

 Note:  most colleges use a Track Code of OV for this purpose. 

If you assign your designated override Track Code to a student, you will also need to change their 

Enrollment Level on the FA tab for the same quarter.  Since there is no enrollment, the Enrollment Level 

for the quarter needs to be 5 (Less Than Half Time).  If the Enrollment Level is not changed on the FA tab, 

the student will receive an error of ‘Stud. Enrolled for fewer credits than range allows’.   
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If a check has already been cut (CC), it may be necessary for you to do a C1 or CR (check recalculation) to 

get the funds to cut instead of an OV. 

 Please keep in mind that this override only bypasses enrollment editing.  It does not bypass errors such 

as “Student is not in the Student Management System’.   Follow the First Method if the student is 

receiving that error on the Rejected Check List Report.   

 

Third Party Payment Query 
This query is designed to pull students with Third Party Payments that have been applied by Student 

Financials. 

Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query 

Enter a new or existing Run Control ID 

Enter the following data: 

●​ Query Name – CTC_DUAL_PROC_THIRD_PARTY_PMTS 

●​ Business Unit 

●​ Term 

●​ Aid Year 

●​ Posted From Date 

●​ Posted to Date 
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Processing Census Date (FAM) 
This process starts with running the Data Express and the file produced will be saved on your PC or 

network drive.   

 

There are 3 different ways by which the Census Day Extract can be pulled:  

1.  Award Code & Track Code (SM9901R) 

2.  Award Code or Sub Code (SM9902R) 

3.  Track Code (SM9903R) 

Users can choose which method works for their specific business processing. Choose any one of the 

DataEx mentioned above to generate the file and proceed with the rest of the instructions. Instructions 

for running each DataEx are explained below. 

 

Census Day Extract (SM9901R) – Option 1 
Cataloged DataExpress Procedure for Census Day Extract selected by Award Code and Track Code.   

DataExpress Procedure SM9901R 

Group Production – INFORM 

Account Production – PLIB 

Group & Account Production:  ../../PLIB/INFORM 

Procedure Password None 

Database Passwords Required SAFER (Username: SAFREAD/ Same as your SAFER Password 

PSSM (Username: SM/ Same as your SM password) 

Report None 

Purpose and Description SM9901R creates a file containing student enrollment level 
data that is loaded into PS.  The file created is a pipe delimited 
file. 

Special Instructions After the procedure runs, you will be prompted to Download, 
Save or Append the file.  You will need to download the file 
with a .CSV extension to a network drive.  Enter D to download 
the file.  You will next be prompted to enter the file pathway.  
For example:  H:\DX\CENSUS.CSV.  After entering in the 
pathway, press Return.  A transfer box will appear as the file is 
downloaded.  When done, the message of ‘Download 
Complete’ appears.  If satisfied with the file, enter N or press 
return with the next 2 prompts.   
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Dependencies None 

Selection Criteria  

YR-SES Enter the year/session from the Award Tab.  For example, 
C123 

AWD-CDE Enter specific Award Codes or leave blank to select all Award 
Codes.  Format is AA,BB,CC or AA OR BB OR CC (where AA, BB, 
and CC are the award codes to include).   Leave blank if 
selecting by Subcodes. 

AWD-SUB-CDE Enter specific Subcodes or leave blank to select all Subcodes.  
Format is 122, 127 or 122 OR 127 where 122 and 127 are the 
subcodes to be included. Leave blank if selecting by Award 
Codes. 

AWD-STATUS Enter specific Award Status or Statuses or leave blank to select 
all Award Statuses.  Format is 1, 2 or 1 OR 2 where 1 and 2 are 
the award statuses to be included. 

YR-SES Enter the year/session from the Tracking Tab.  For example, 
C121 

TRACK-CODE Enter the specific Track Code 

SES-YR-START Enter the year/session start from the Financial Aid tab.  For 
example, C121 

Version Date 4/27/2022 

 
 

Census Day Extract (SM9902R) – Option 2 
Cataloged DataExpress Procedure for Census Day Extract selected by Award Code or Subcode.   

DataExpress Procedure SM9902R 

Group Production – INFORM 

Account Production – PLIB 

Group & Account Production:  ../../PLIB/INFORM 

Procedure Password None 

Database Passwords Required SAFER (Username: SAFREAD/ Same as your SAFER Password 

PSSM (Username: SM/ Same as your SM password) 
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Report None 

Purpose and Description SM9902R creates a file containing student enrollment level 
data that is loaded into PS.  .The file created is a pipe delimited 
file. 

Special Instructions After the procedure runs, you will be prompted to Download, 
Save or Append the file.  You will need to download the file 
with a .CSV extension to a network drive.  Enter D to download 
the file.  You will next be prompted to enter the file pathway.  
For example:  H:\DX\CENSUSC123.CSV.  It is recommended 
that you include the quarter code in the title.  After entering in 
the pathway, press Return.  A transfer box will appear as the 
file is downloaded.  When done, the message of ‘Download 
Complete’ appears.  If satisfied with the file, enter N or press 
return with the next 2 prompts.   

Dependencies None 

Selection Criteria  

YR-SES Enter the year/session from the Award Tab.  For example, 
C123 

AWD-CDE Enter specific Award Codes or leave blank to select all Award 
Codes.  Format is AA,BB,CC or AA OR BB OR CC (where AA, BB, 
and CC are the award codes to include).   Leave blank if 
selecting by Subcodes. 

AWD-SUB-CDE Enter specific Subcodes or leave blank to select all Subcodes.  
Format is 122, 127 or 122 OR 127 where 122 and 127 are the 
subcodes to be included. Leave blank if selecting by Award 
Codes. 

AWD-STATUS Enter specific Award Status or Statuses or leave blank to select 
all Award Statuses.  Format is 1, 2 or 1 OR 2 where 1 and 2 are 
the award statuses to be included. 

SES-YR-START Enter the year/session from the Tracking Tab.  For example, 
C123 

Version Date 4/27/2022 

 

Census Day Extract (SM9903R) – Option 3 
Cataloged DataExpress Procedure for Census Day Extract selected by Track Code.   

DataExpress Procedure SM9903R 
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Group Production – INFORM 

Account Production – PLIB 

Group & Account Production:  ../../PLIB/INFORM 

Procedure Password None 

Database Passwords Required SAFER (Username: SAFREAD/ Same as your SAFER Password 

PSSM (Username: SM/ Same as your SM password) 

Report None 

Purpose and Description SM9903R creates a file containing student enrollment level 
data that is loaded into PS.  .The file created is a pipe delimited 
file. 

Special Instructions After the procedure runs, you will be prompted to Download, 
Save or Append the file.  You will need to download the file 
with a .CSV extension to a network drive.  Enter D to download 
the file.  You will next be prompted to enter the file pathway.  
For example:  H:\DX\CENSUS.CSV.  After entering in the 
pathway, press Return.  A transfer box will appear as the file is 
downloaded.  When done, the message of ‘Download 
Complete’ appears.  If satisfied with the file, enter N or press 
return with the next 2 prompts.   

Dependencies None 

Selection Criteria  

YR-SES Enter the year/session from the Tracking Tab.  For example, 
C121 

TRACK-CODE Enter the specific Track Code or codes separated by a comma 

SES-YR-START Enter the year/session start from the Financial Aid tab.  For 
example, C121 

  

Version Date 4/27/2022 
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Processing Census Date (PeopleSoft) 
The Census Date process allows users to pull query values that show enrollment levels for financial aid 

students.  This is based on the student population that is supplied via the previous processing done in 

FAM.  The file created will be loaded in PeopleSoft and added to the Query Reporting table.  The 

Schedule Query page is used to find the student file that was loaded and produce a report that shows 

enrollment values for those students.  The report is used to compare enrollment values in FAM. 

 

Pre-requisites 
●​ The extract process - SM9903R, described in the previous step needs to be successfully run AND 

should have data generated. 

 

Known Issues 
●​ The user doesn’t have access to navigation: 

o​ The security role to access that menu is missing from the user profile. Contact your local 

security administrator. 

 

Navigation:  Nav Bar > PeopleTools > CTC Custom > Extensions > Upload/Download Files 

From the Upload/Download Files page enter the following information: 

●​ Academic Institution 

●​ Functional Area – Financial Aid  

●​ Business Process Name – Dual Processing 
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From the Upload Files tab select Upload File link and choose the file saved on your PC or network drive. 

Save the file path in the following screen as it will be used in later steps. 

 

 

When the File Attachment window opens select Choose File and select the desired file (generated after 

running SM9903R job) 

 

Select Upload 

 

Once the file is loaded the following message will appear 

 

Select OK 
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Loading the File to the Query Reporting Table  
The following steps assist with loading the file to the Query Reporting Table for use in subsequent 

processing.  

Navigation:  Nav Bar > Campus Community > CTC Custom > CTC Query Reporting Table 

Enter a New or Existing Run Control ID (Note this run-control will be used in the later step in running the 

query) 

Enter the following data: 

●​ File Path and File Name (Use the file path saved from above step and include the file name you 

uploaded. This is case sensitive.) 

●​ File Type – Delimited 

●​ User ID – User’s ID 

●​ Field Delimiter - | (pipe)  

Select Run 

 

 

 

 

From the Process Scheduler Request page ensure the Load Query Reporting Table is selected 

Select OK 
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Once directed back to the Query Reporting Table select the Process Monitor link 

 

 

From the Process Monitor page ensure the process runs to Success and Posted 

 

This completes loading data into Query Reporting tables. Retain the prompt values for subsequent steps. 
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Running the Census Extract Query 
The following steps allow users to pull enrollment values for the student population loaded in the 

previous processes. The Census Extract query can be run after you have successfully loaded the Data 

following the process described above.  

 

Pre-requisites 
●​ The Census extract process described in the previous step needs to be successfully run AND 

should have data generated. 

●​ Should use the Run control ID from the previous step to load data in the query reporting table.  

 

Known Issues 
●​ The query generates no results: 

o​ The run control ID provided was run by another user. 

o​ The run control ID provided is incorrect/not matching the one used to load census data 

into query reporting tables. 

  

Navigation:  Nav Bar > Reporting Tools > Query > Schedule Query 

Enter a New or Existing Run Control ID 

From the Schedule Query page enter the query name and select Search 

CTC_FA_CENSUS_EXTRACT_I113 
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When the Scheduled Query Search Page opens with the query located select on the  

CTC_FA_CENSUS_EXTRACT_I113 link  

 

 

The Edit Prompts window will open, enter the following: 

●​ Run Cntl – This is the Run Control ID used for Loading the File to the Query Reporting Table, Pg 

78) 

●​ Institution 

●​ Term  

●​ Select OK 
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Once directed back to the Schedule Query page the process is ready to run 

Select Run 

 

 

From the Process Scheduler Request page ensure PSQUERY is selected 

 

 

 

Once directed back to the Schedule Query page select the Process Monitor link 
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From the Process Monitor page ensure the process runs to Success and Posted 

Select the Details link 

 

 

From the Process Detail page select the View Log/Trace link 
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When the View Log/Trace page opens select on the CTC_FA_CENSUS_EXTRACT_I113-xxxxxxxx.csv link 

(where “x” represents processing number)  

 

Once selected an Excel Spreadsheet will open. 

 

Reviewing the Census File 
When reviewing the Census file, filter the headers in the file, specifically filtering the column labeled 

Load Difference. Find all the Load differences with Y as the Value (Y = Yes, there is a Load Difference).  

You will be looking for Enrollment Load differences between what is recorded in the Enrollment page in 

FAM, and the FA Load in FA Term in PeopleSoft.  When reviewing this file, the goal is to find all Load 

Differences of Y (Yes) and make the determination of whether or not the award in FAM needs to be 

reduced (or increased) before the award is recorded in View Customer Accounts in ctcLink. 

The image below is what the .csv file looks like displaying the column for FAM Load, PS FA Load and Load 

Difference.  Find all the Load Difference values of “Y”, and adjust awards in FAM as necessary.  

Additionally, make adjustment to the FAM enrollment tab as necessary too, if the enrollment load has 

changed since the time the Award was made. 
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The Excel spreadsheet contains the following: 

●​ EMPL ID 

●​ Last Name 

●​ First Name 

●​ Date of Birth 

●​ SSN 

●​ Term  

●​ FAM Load 

●​ PeopleSoft FA Load (from FA Term) 

●​ Acad Load (Academic Load value found on FA Term) 

●​ Load Difference 

●​ FA Taken (Unit value taken per FA Term) 

●​ Loan Year (value from FA Term) 
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Checking the Data in the Census Extract File 
To validate the data in the Census Extract file, perform the following steps: 

●​ "While the Census Extract spreadsheet is still open, ensure that the following fields are 

populated for all students: 

o​ ID, Last Name, First Name, Date of Birth, SSN, FAM Load, and FA Taken (even if zero)." 

●​ Open the legacy Census Extract spreadsheet 

●​ For all students in the PeopleSoft Census Extract spreadsheet, make sure the FAM Load value 

matches the value in the Census Data Express spreadsheet.  

●​ For students in the PeopleSoft Census Extract spreadsheet, make sure the number of units listed 

in the FA Taken column translates correctly to the PS FA Load value. In addition verify all FA 

Progress greater than zero are summed for courses the student is enrolled in for the prompted 

term. (Records and Enrollment > Enroll Students > Enrollment > FA Progress field) 

●​ If the load value between FAM Load and PS FA Load is different, then the "Load Difference" 

column should contain 'Y'. If the values are the same, the column should contain 'N'. 

●​ Verify that the Loan Year value matches the translate value in the Academic Level fields in 

Student Career Term (Records and Enrollment > Student Term Information > Term Activate a 

Student) 

●​ Students who have a blank value in the Term, PS FA Load, Load Difference and Loan Year fields 

are students who exist in the legacy Data Express file, but do not have enrollment information 

for the prompted term, institution and/or EmplID. (Records and Enrollment > Enroll Students > 

Enrollment) 
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Running the Withdrawn Query 
This query will show any student that has a ‘W’ (Withdrawn) whether they fully withdrew or only 

withdrew from partial classes. 

This is very similar to the census query with a few additional steps. 

 

Pre-requisites 
●​ You will need to create/use the Census file.  Follow the steps to generate a Census extract file, if 

you do not already have a Census file. Once the file is generated then jump back here and follow 

steps. 

 

Known Issues 
●​ The query generates no results: 

o​ There are no students withdrawn for the term for which the query is run. 

o​ The run control ID entered in prompts for query is not the one used to load data in query 

reporting table.  

 

For the process the same census file produced from HPUX will be used.  

●​ Take the census file from HPUX and open it in Excel 

 

●​ Remove the duplicates from the list 

o​ This is done by selecting Data the Remove Duplicates 
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Save this version.  (Yes, this means you’ll have 2 versions of the census file.  Just remember to name it to 

know which file is census and which file is withdrawal) 

 

This file can now be uploaded to ctcLink and then loaded to the Query Reporting Table.  Follow the steps 

below to upload and load into the Query Reporting Table. 

Note: When at the step of loading the data to the Query Reporting Table is recommended to use a 

different run control than what was used for the Census Extract. 

 

Upload the File to ctcLink 
Navigation:  Nav Bar > Navigator > PeopleTools > CTC Custom > Extensions > Upload/Download Files 

From the Upload/Download Files page enter the following information: 

●​ Academic Institution 

●​ Functional Area – Financial Aid  

●​ Business Process Name – Dual Processing 

 

From the Upload Files tab select Upload File link and choose the file saved on your PC or network drive. 

Save the file path in the following screen as it will be used in later steps. 
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When the File Attachment window opens select Choose File and select the desired file (generated after 

running SM9903R job) 

 

Select Upload 

 

Once the file is loaded the following message will appear 

 

Select OK 
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Loading the Census Data to the Query Reporting Table Using a Run Control ID for 
Withdrawn Students 
The following steps assist with loading the file to the Query Reporting Table for use in subsequent 

processing.  

Navigation:  Nav Bar > Campus Community > CTC Custom > CTC Query Reporting Table 

Enter a New or Existing Run Control ID (Note this run-control will be used in the later step in running the 

query) 

Enter the following data: 

●​ File Path and File Name (Use the file path saved from above step and include the file name you 

uploaded. This is case sensitive.) 

●​ File Type – Delimited 

●​ User ID – User’s ID 

●​ Field Delimiter - | (pipe) 

Select Run 

 

 

At the Process Scheduler Request page, select the OK button. 

 

 

Once Success and Posted, you will now run the withdrawn query using Schedule Query. 
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Running Withdrawn Query in Schedule Query 
Navigation:  Nav Bar > Navigator > Reporting Tools > Schedule Query  

For this process you will use the following: 

●​ Query Name – CTC_FA_DUAL_PROCESSING_WDRW 

●​ Select Search 

 

 

Select the query hyperlink, which will then open a Display box for edit prompts: 

 

 

 

In the prompts display box, enter: 

●​ Institution ID 

●​ Term  

●​ Run Control ID = This will be the Run Control ID used while loading your new file into the Query 

Reporting Table 

●​ Select OK 
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Select the Run button. 

 

 

 

At the Process Monitor page, select OK.   

Ensure your process runs to Success and Posted. 

Note—select Update Parameters to update any values for your Term or Run Control ID that may change from term 

to term. 
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Running the Unofficial Withdrawals Query 
This query will show any student that has a combination of ALL ‘F’ & ‘W’ (Unofficially Withdrawn) grades 

for a given term. This report should be run after all grades have been posted for the term to find 

unofficially withdrawn students for R2T4.  

 

Pre-requisites 
●​ You will need to create/use the Census file. Follow the steps listed in the Census section of the 

doc to generate a Census extract file, if you do not already have a Census file.  

●​ After creating the census file, you will modify the file and create a “Withdrawn” file in the steps 

just prior to this section in “Running the Withdraw Query.” 

●​ You will need to note the Run Control ID used to load the “Withdrawn” csv file to the query 

reporting table 
 

Known Issues 
●​ The query generates no results: 

o​ There are no students unofficially withdrawn for the term for which the query is run. 

o​ The run control ID entered in prompts for query is not the one used to load data in query 

reporting table when the user loaded the “Withdrawn” csv file to the query reporting 

table.  

 

You will run the query above using Schedule Query. 

Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query  

For this process you will use the following: 

●​ Query Name – QCS_FA_DUAL_PROCESSING_UNOFF_W 

 

 

 

Next, select the query hyperlink. 

 

101 | Page 
May 23, 2022 



FA Dual Processing 
 

 

 

In the prompt display, enter: 

●​ Institution ID 

●​ Term  

●​ Run Control ID = This will be the Run Control ID used while loading your “withdrawn csv” file 

into the Query Reporting Table 

 

 

 

Run this query in Schedule Query from the file you loaded into the Query Reporting Table 
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Note—select Update Parameters to update any values for your Term or Run Control ID that may change from term 

to term. 

Student Worker Payroll Extract 
The student Worker Payroll extract is a query designed to pull student data and work study earnings.  
The report will be reviewed and utilized by the colleges to manually update work study awards in FAM.  

 

Pre-requisites 
●​ Payroll data needs to be available in the environment running the query. 

 

Known Issues 
●​ The query generates no results: 

o​ The student’s worker data may not have been loaded on the payroll (HCM) side of 

ctcLink.   

 

Once the spreadsheet is open, browse through and verify that the following columns are populated with 
data: 

●​ ID 
●​ NID (aka SSN) 
●​ Last Name  
●​ First Name 
●​ Expenditure Code 
●​ Item Type 
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●​ A variety of dollar amounts from HR payroll under the Summer Disbursed, Fall Disbursed, Winter 
Disbursed or Spring Disbursed. 

●​ A dollar amount other than zero should also be included under the Total column 

Navigation:  Nav Bar > Navigator > Reporting Tools > Schedule Query  

Enter a new or existing Run Control ID 

●​ Enter Query Name - CTC_FA_STDWRK_EXTRACT_I115 

●​ Select Search 

 

 

 

From the Scheduled Query Search Page select the query link 

 

 

Edit Prompts will appear 

Enter the following: 

●​ Institution 

●​ Aid Year 

●​ Select OK 
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Once the Edit Prompts are entered the user will be directed back to the Schedule Query page with the 

Update Parameters details 

●​ Select Run 

 

 

From the Process Scheduler Request page select OK 

 

 

 

 

 

 

 

From the Schedule Query page select the Process Monitor link  
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From the Process List ensure the process runs to Success and Posted 

Select the Details link 
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From the Process Detail page select View Log/Trace 

 

 

From the View Log/Trace page select the CTC_FA_STDWRK_EXTRACT_I115-xxxxxx.csv link 
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Based on your browser an Excel Spreadsheet download will appear 

Use this excel doc to manually update work study awards to reflect actual earnings in FAM  
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Dual Processing Reconciliation 
 

Student Financials Reconciliation Extract (SM9904R) 
 

Known Issues 
●​ Three character values entered in the FAM Sub Code field that do not represent a 

scholarship source will be included in the file and may cause issues.  It is recommended 

to stop using three character values in the FAM Sub Code field that are not scholarships 

or manually remove them from the file.    Values that are less than or greater than three 

characters will be automatically removed.  If you need assistance with that task, please 

open a ticket after creating the extract file.  The FA Support team will help you remove 

the non-scholarship Sub Codes from the file.     

 

Cataloged DataExpress Procedure for SAP and Student Financials Reconciliation Extract selected by 

Award Code.   

DataExpress Procedure SM9904R 

Group Production – INFORM 

Account Production – PLIB 

Group & Account Production:  ../../PLIB/INFORM 

Procedure Password None 

Database Passwords Required SAFER (Username: SAFREAD/ Same as your SAFER Password 

PSSM (Username: SM/ Same as your SM password) 

Report None 

Purpose and Description SM9904R creates a file containing student award data that is 
loaded into PS.  .The file created is a pipe delimited file. 

Special Instructions After the procedure runs, you will be prompted to Download, 
Save or Append the file.  You will need to download the file 
with a .CSV extension to a network drive.  Enter D to download 
the file.  You will next be prompted to enter the file pathway.  
For example:  H:\DX\RECON_FA_SF.CSV.  After entering in the 
pathway, press Return.  A transfer box will appear as the file is 
downloaded.  When done, the message of ‘Download 
Complete’ appears.  If satisfied with the file, enter N or press 
return with the next 2 prompts.   

Dependencies None 
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Selection Criteria  

YR-SES Enter the year/session from the Award Tab.  For example C123 

AWD-CDE Enter specific Award Codes or leave blank to select all Award 
Codes.  Format is AA,BB,CC or AA OR BB OR CC (where AA, BB, 
and CC are the award codes to include).   Leave blank if 
selecting by Subcodes. 

AWD-SUB-CDE Enter specific Subcodes or leave blank to select all Subcodes.  
Format is 122, 127 or 122 OR 127 where 122 and 127 are the 
subcodes to be included. Leave blank if selecting by Award 
Codes. 

AWD-STATUS Enter specific Award Status or Statuses or leave blank to select 
all Award Statuses.  Format is 1, 2 or 1 OR 2 where 1 and 2 are 
the award statuses to be included. 

  

Version Date 4/22/2021 
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Student Financial Reconciliation Extract 
To retrieve students for Student Financial Reconciliation processing, begin by navigating to the Query 

Reporting Table. This process allows you to upload the Reconciliation extract Data Express file run on the 

HPUNIX. 

 

Pre-requisites 
●​ The data extract process described in the previous step needs to be successfully run AND should 

have data generated. 

 

Uploading the Student Financial Reconciliation Extract Data 
Navigation:  Nav Bar > Navigator > People Tools > CTC Custom > Extensions > Upload/Download Files 

Enter the following information: 

●​ Academic Institution 

●​ Functional Area 

●​ Business Process Name 

●​ Select Search 
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From the File Upload/Download page select Upload File and choose file from your PC or Network drive. 

 

 

Once the file is selected select Upload  
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Loading Extract Data to the Query Reporting Table 
Navigation:  Nav Bar > Navigator > Campus Community > CTC Custom > CTC Query Reporting Table 

Enter a new or existing Run Control ID 

Enter the following data: 

●​ File Path and File Name – Provide File path and File name saved from previous step. 

●​ File Type – Delimited 

●​ User ID – User’s ID 

●​ Field Delimiter - |   (pipe) 

Select Run 

 

 

Ensure process runs to Success and Posted 
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Running the Reconciliation Extract Query  
Reconciliation Extract query can be run after you have successfully loaded the data to query reporting 

table as described above. This query shows the data generated and extracted to a file after a successful 

run of the extract above. 

 

Pre-requisites 
●​ The data should be successfully loaded described in the previous step. 

●​ Should have the Run control ID used to load the data into Query Reporting tables from previous 

step. 

 

Known Issues 
●​ The process goes to ‘No Success’: 

o​ The Run control ID provided was not the one used to load data in query reporting table. 

o​ The Run control ID provided was run by another user. 

o​ The file name provided was not the one used to load data in query reporting table from 

previous steps. 

o​ The file path provided is incorrect i.e. – spaces in between characters, incorrect file path 

(refer previous step to get correct one). 

 

Navigation:  Nav Bar > Reporting Tools > Schedule Query  

 
Enter a New or Existing Run Control ID 

From The Schedule Query page enter the Query Name: CTC_FA_RECON_EXTRACT_I114 

Select Search 
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From the Scheduled Query Search Page select the query link 

 

 

The Edit Prompts box will open  

Enter the following: 

●​ The Run Control ID used when loading the file to the Query Reporting Table  

o​ Example:  FA_Recon 

●​ Institution 

●​ Select OK 
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You will be returned to the Schedule Query page with the required parameters 

Select Run  

 

 

From the Process Scheduler Request page select OK 
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You will be directed back to the Schedule Query page 

Select the Process Monitor link 

 

From the Process Monitor page select the Details link 
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When the Process Detail page opens select the View Log/Trace link 
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When the View Log/Trace page opens select the CTC_FA_RECON_EXTRACT_I114-xxxxxxx.csv  (where “x” 

is an assigned number during the process) 

 

 

Depending on your browser, an Excel Spreadsheet with the data from the query will open 
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The data is used to compare what has been disbursed to what has been posted in PeopleSoft.  If the 

column for FAM Amount is different than the PS Applied Amount, determine which is correct, and adjust 

award. 

 

 

 

 

 

Dual Processing Satisfactory Academic Progress 
This process uses the subset of students selected when running the SM9904R Extract.   

 

SAP Extract SM9904R 

Known Issues 
●​ Three character values entered in the Subcode field that do not represent a scholarship 

source will be included in the file and may cause issues.  It is recommended to stop using 

three character values in the Subcode field that are not scholarships or manually remove 

them from the file.  Values that are less than or greater than three characters will be 

automatically removed.  If you need assistance with that task, please open a ticket after 

creating the extract file.  The FA Support team will help you remove the non-scholarship Sub 

Codes from the file.   

   

Cataloged DataExpress Procedure for SAP Extract selected by Award Code.   

DataExpress Procedure SM9904R 

Group Production - INFORM 

Account Production – PLIB 

Group & Account Production:  ../../PLIB/INFORM 

Procedure Password None 

Database Passwords Required SAFER (Username: SAFREAD/ Same as your SAFER Password 

PSSM (Username: SM/ Same as your SM password) 

Report None 

Purpose and Description SM9904R creates a file containing student award data that is 
loaded into PS.  .The file created is a pipe delimited file. 
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Special Instructions After the procedure runs, you will be prompted to Download, 
Save or Append the file.  You will need to download the file 
with a .CSV extension to a network drive.  Enter D to download 
the file.  You will next be prompted to enter the file pathway.  
For example:  H:\DX\SAP_2221.CSV.  After entering in the 
pathway, press Return.  A transfer box will appear as the file is 
downloaded.  When done, the message of ‘Download 
Complete’ appears.  If satisfied with the file, enter N or press 
return with the next 2 prompts.   

Dependencies None 

Selection Criteria  

YR-SES Enter the year/session from the Award Tab.  For example C123 

AWD-CDE Enter specific Award Codes or leave blank to select all Award 
Codes.  Format is AA,BB,CC or AA OR BB OR CC (where AA, BB, 
and CC are the award codes to include).   Leave blank if 
selecting by Subcodes. 

AWD-SUB-CDE Enter specific Subcodes or leave blank to select all Subcodes.  
Format is 122, 127 or 122 OR 127 where 122 and 127 are the 
subcodes to be included. Leave blank if selecting by Award 
Codes. 

AWD-STATUS Enter specific Award Status or Statuses or leave blank to select 
all Award Statuses.  Format is 1, 2 or 1 OR 2 where 1 and 2 are 
the award statuses to be included. 

  

Version Date 4/27/2022 

 

Upload SAP Extract to ctcLink 
To retrieve students for SAP processing in ctcLink, begin by uploading the SAP extract file to ctcLink. Next, 

navigate to the Query Reporting Table to load the data into the reporting tables, where you can then run 

a query in Schedule Query to extract your data into a sortable excel doc for SAP review. 

 

Pre-requisites 
●​ The data extract process described in the previous step needs to be successfully run AND should 

have data generated. 

 

Navigation:  Nav Bar > Navigator > People Tools > CTC Custom > Extensions > Upload/Download Files 

Enter the following information: 
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●​ Academic Institution 

●​ Functional Area 

●​ Business Process Name 

●​ Select Search 

 

 

From the File Upload/Download page select Upload File and choose file from your PC or Network drive. 

 

Once the file is selected, select Upload  
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Loading Extract Data to the Query Reporting Table 
 

Navigation:  Nav Bar > Navigator > Campus Community > CTC Custom > CTC Query Reporting Table 

Enter a new or existing Run Control ID 

Enter the following data: 

●​ File Path and File Name – Provide File path and File name saved from previous step. 

●​ File Type – Delimited 

●​ User ID – User’s ID 

●​ Field Delimiter - |   (pipe) 

Select Run 

 

 

Ensure process runs to Success and Posted 
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Aid Year Activation 
This process starts by Aid Year Activating the students in PeopleSoft whose data was loaded into the 

query reporting table.  

Navigation:  Nav bar > Financial Aid > Aid Year Activation > Process Financial Aid Years  

Enter a New or Existing Run Control ID 

Select Search 

From the Aid Year Activate page enter the following information: 

●​ Selection Tool – PS Query 

●​ Query Name - CTC_FA_AIDYR_ACTIV_I118 

●​ Select ‘Edit Prompts’ and enter the following: 

o​ Run Control ID – This is the Run Control ID used to load data in query reporting tables in 

the previous process. 

o​ Select OK 

●​ Academic Institution  

●​ Aid Year  

 

 

Optional – Select Preview Selections Results (highlighted in image above) 

Note a couple of student IDs for review after the process is run 
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●​ Select Run 

 

From the Process Scheduler Request page ensure the SFA_ACTADYR is selected 

Select OK 

 

 

 

Once directed back to the Aid Year Activate page select Process Monitor 

 

 

From the Process Monitor page ensure the process runs to Success and Posted  

Select the Details link 
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From the Process Details page select Message Log 

 

The Message Log will display the number of students processed for the Institution and Aid Year 
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You can validate that the IDs in Activate Aid Year processed by navigating to the FA Status page and 

entering the ID, Academic Institution, and Aid Year the student was activated for.  If the student was not 

successfully aid year activated, you would not be able to find the student in this View Financial Aid Status 

page. 

Navigation:  Nav Bar > Financial Aid > View Financial Aid Status 

 

 

130 | Page 
May 23, 2022 



FA Dual Processing 
 

Building FA Term - Create FA Term Driver Records 
The next step in the process is building FA Term for the same group of students 

The FA Term Process is a 2 step process that begins with creating the FA Term Driver Records 

 

Navigation:  Nav Bar > Financial Aid > Financial Aid Term > Create FA Term Driver Records  

Enter a New or Existing Run Control ID 

Enter the following information: 

●​ Academic Institution 

●​ Aid Year – Same Aid Year used in the previous process 

●​ Driver Creation Option – Both Updates and Projections 

●​ Select Career – UGRD  

●​ Ensure Rebuild Projections box is checked  

●​ Select Run 

 

 

 

From the Process Scheduler Request page ensure the Create Driver Recs For FA Term box is checked. 

Select OK 
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Once directed back the Create FA Term Driver Records page select the Process Monitor link 

 

 

From the Process Monitor page ensure the process runs to Success and Posted 

Select the Details link 
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From the Process Detail page select Message Log 

 

Ensure the process runs successfully 

 

The second step in the process is the Build FA Term in Batch process 
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Building FA Term - Build FA Term in Batch 
Navigation:  Nav Bar > Financial Aid > Financial Aid Term > Build FA Term in Batch 

Enter a New or Existing Run Control ID 

Enter the following information: 

●​ Academic Institution 

●​ Aid Year – Same Aid Year used in the previous process 

●​ Commit Level – 500 

●​ Driver Creation Option – Both Updates and Projections 

●​ Select Run 

 

 

From the Process Scheduler Request page ensure the FA Term Build Process is selected  

Select OK 

 

Once directed back to the Build FA Terms page select Process Monitor 
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From the Process Monitor page ensure the process has run to Success and Posted  

Select the Details link 
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From the Process Detail page select the message log to review the outcome 

 

 

From the Message Log page review the outcome 

 

Users can review the IDs processed by navigating to the FA Status page and entering the ID, Academic 

Institution, and Aid Year the student was activated for.  
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Navigation:  Nav Bar > Financial Aid > Financial Aid Term > Maintain Student FA Term 
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Processing SAP 
The last step is to run the SAP process for the group of students that just had their Aid Year Activated and 

FA Terms Built  

 

Known Issues 
●​ When re-using a run control ID, the ‘Population Selection’ section might be greyed out. To 

enable the ‘Population Selection’ section, follow below steps: 

o​ Scroll down on the run-control page to ‘Input Parameters’ Section. 

o​ From ‘Selection Criteria’ drop-down, choose – ‘Population Selection’  

o​ You will see the ‘Population Selection’ section being enabled.  

 

Navigation:  Nav Bar > Financial Aid > Satisfactory Academic Progress > Process SAP 

Enter a New or Existing Run Control ID 

Enter the following information: 

●​ Selection Tool – PS Query 

●​ Query Name - CTC_FA_SAP_I118 

 

 

 

●​ Select ‘Edit Prompts’ and enter the following parameters for student selection: 

o​ Run Control - This is the Run Control ID used in the previous process for loading students 

into the Query Reporting Table.  
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Back at the SAP Batch Process page, enter: 

 

●​ Academic Institution 

●​ Academic Career - UGRD 

●​ Term 

●​ Selection Criteria – Population Selection 

●​ Processing Option – Update and Report 

●​ Select Update using most recent evaluation term 

●​ Select Any Calculation Value Change 

●​ Select Run 

 

From the Process Scheduler Request page select SFA_SAP_BDRV 

Select OK 
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Once directed back to the Process SAP page select the Process Monitor link 

 

 

From the Process Monitor page ensure the process runs to Success and Posted 
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Reviewing SAP Report  
The SAP Report will allow a user to view the recently calculated SAP values.     

Navigation:  Nav Bar > Financial Aid > Satisfactory Academic Progress > Review Report Data 

Enter the following: 

●​ User ID – This is the ID of the user that ran Process SAP 

●​ Run Control ID – Enter the SAP Run Control ID used for Process SAP step above. Ref Pg 120. 

●​ Select Search  
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Running the SAP Query 
The CTC_FA_DUAL_PROCESSING_SAP_RPT query was created to allow the colleges to pull the View SAP 

Report to include SSNs during Dual Processing.   

 

Navigation:  Nav Bar > Reporting Tools > Schedule Query  

 

Enter a New or Existing Run Control ID 

From the Schedule Query page enter the Query Name ​  

CTC_FA_DUAL_PROCESSING_SAP_RPT  

Select Search 

 

 

 

From the Scheduled Query Search Page select the Query link 

 

The Edit Prompts will open.  Enter the following: 

●​ Run Control ID – Enter the SAP Run Control ID used for Processing SAP step above 

●​ User – This will be the User (EMPL) ID of the person who ran the SAP Process 
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●​ Select OK 

 

 

When returned to the Schedule Query page and values are correctly populated select Run 
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From the Process Scheduler Request page ensure the PSQUERY box is marked and select OK 

 

 

 

From the View Process Request page select Details 

 

 

144 | Page 
May 23, 2022 



FA Dual Processing 
 

From the Process Detail page select View Log/Trace 

 

 

From the View Log/Trace page select CTC_FA_DUAL_PROCESSING_SAP_RPT-xxxxxx.csv  
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Assigning Service Indicators 
During Dual Processing users will be able to Mass Assign Service Indicators by using External File Load.  

This process requires that a list of EMPL IDs be loaded via an Excel Spreadsheet.  It is important to note 

that the file needs to be saved as a .csv file for the processing to work.  

Create a list of student EMPL IDs that will be assigned the desired Service Indicator.  Save the file to the 

computer or local hard drive.   

 

 

*Remember to save the file as a CSV (Comma delimited) 

 

 

​
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From the Mass Assign page (Navigation: Nav Bar > Navigator > Campus Community > Service 

Indicators > Person > Mass Assign) enter the following data: 

Population Selection  
●​ Selection Tool – External File 

●​ Select Upload File – Select Browse to load desired file 

●​ File Mapping – Use look up tool to select EMPLID ONLY 

●​ Select Preview Selection Results to verify the file loaded correctly 

Service Indicator Data  
●​ Institution – Select desired institution 

●​ Service Indicator – User look up tool to select desired Service Indicator 

●​ Reason – Ensure Reason Code is selected or use look up tool to select value 

Effected Period  
●​ Start Term - Enter desired Start Term 

●​ End Term  - Enter desired End Term 

●​ Start Date - Enter desired Start Date 

●​ End Date - Enter desired End Date 

Assignment Details 
●​ Department – Default values is Financial Aid (numeric value will populate) 

Select Run 
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From the Process Scheduler Request page ensure the following is selected: 

SCC_SI_ASSN 

Select OK 
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Ensure process runs to Success and Posted.  

 

Service Indicators have now been assigned.  
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Viewing Assigned Service Indicators 
Navigation:  Nav Bar > Campus Community > Service Indicators (Student) > Manage Service Indicators  

Enter EMPL ID and select Search 

 

Select the Code Value to view the assigned Service Indicator 
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Global Financial Aid Service Indicator List 
 

 

Navigation Tips 
The Navigation Tips section is a list of common pages used by Financial Aid Staff.  

 

Student Services Center (Student) 
Use the Student Services Center (Student) page and the data contained in the page top review the 

following:  

Navigation > Campus Community > Student Services Ctr (Student) 

Student Center Tab 
●​ Student Schedule 

●​ To Do List (Checklists that students can see) 

●​ Message Center link 

●​ Account Inquiry link 

●​ View Financial Aid link 

o​ FA Shopping Sheet (College Financing Plan) link 

o​ Financial Aid Summary link 

o​ Satisfactory Academic Progress link 

o​ View Scheduled Disbursement Dates link 

General Info Tab 
●​ Service Indicators 

●​ Student Groups 

●​ Bio/demo info 

●​ Checklists 

Academics Tab 
●​ Program/Plan 

●​ Term information on unit load and classes 

Finances Tab 
●​ Total Tuition and Fees 

●​ Total Waiver 

●​ Account information 

●​ Charges due 
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●​ Refund information 

●​ Bills 

●​ Payment Plans 

Financial Aid Tab 
●​ Institution/Aid Year 

●​ View Packaging Status Summary 

●​ Award Summary for Aid Year 

●​ Term Summary for Aid Year 

●​ Student Award Summary link 

●​ Student Budget link 

 

Residency 
Navigation-Campus Community-Person Information (Student)-Identification (Student)-Residency Data 

Enrollment Request Search 

Navigation-Records and Enrollment-Enroll Students-Enrollment Request Search 

●​ On this page you can view enrollment activity per student when you enter the Academic Career, 

Term, and Empl ID fields.  Proper security may be required to view this page. 
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Glossary 
S. No Reference Description 
1 PS PeopleSoft  
2 STRM Student Term 
3 PSQUERY PeopleSoft Query 
4 INST Institute 
5 BPG Business Process Guide 
6 DP Dual Processing 
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